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Introduction 
The Automated Cost Reporting & Evaluation System (ACRES) is the result of a desire to conduct 
report processing in an electronic format.  ACRES provides many advantages over the manual 
“paper” reporting process.  One such advantage is the ability to include code that allows the 
Provider to test the reported data to ensure that it meets certain criteria before it is submitted.  This 
testing or “editing” capability will eliminate common errors such as missing data and incorrect 
calculations. 

ACRES also gives many capabilities to staff that process the data once it has been submitted.  One 
key advantage is the ability to store data in such a way as to allow for identification of the reported 
data as well as any adjustments made to that data.  This permits the generation of reports that can 
be sent to Providers to inform them of adjustments made to their submitted data.  Feedback such 
as this can serve to help the Provider eliminate the need for similar adjustments on future reports. 

In the ACRES system, there are three major applications: Builder, Data Entry and Adjuster.  
These three applications work together, and they cannot operate successfully without the other. 
However, these applications do function independently. The Builder is used to design and set up 
the data format, the Data Entry application is used to apply the data format to collect data. 
Finally, those collected data are scrutinized through the Adjuster application. 

The Data Entry manual was designed to walk the user through the creation of an electronic cost 
report.  You will notice that this manual is organized sequentially in a logical progression through 
the preparation of a cost report.  Therefore, it is recommended that chapters not be skipped.  You 
will often need some understanding of previous chapters to comprehend the later chapters. 

Because ACRES is a Windows based software, the layout should be familiar to anyone with the 
most basic Windows knowledge.  It has many of the same features like pull-down menus, buttons, 
and the over all look is similar.  This familiarity should aid you when navigating through ACRES. 

Any questions or comments should be forwarded to ACRES Technical Support.  
Information for Technical Support can be found on page 35. 
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To Install ACRES 
ACRES Data Entry requires a system that can run a minimum of Windows 95 and a 
minimum of  20 MB of hard drive space. 

The ACRES Data Entry software can be downloaded from the following site: 
http://www.hhsc.state.tx.us/rad/index.shtml 

Once at the website select the link for “Long Term Care Services”, click “ACRES”, then select 
the Year of the report type that you will be preparing. 

Follow these instructions to install ACRES Data Entry Software: 

 Click on the “Click here to begin the ACRES Install” link to start install. 
  
 A download box will automatically appear, Select Run from current location or Open. 
 
 You will be asked if you want to download Setup.exe, click YES.  Upon download, the 

install wizard will guide you through the setup.  If you are running Windows XP you may 
receive a Security Warning stating that the Publisher could not be verified and asking if 
you are sure you want to run this software.  Click Run to begin the installation. 

 
 When the installation has finished, you will see a check box indicating that you 

can launch the program.  If you don’t want to start the ACRES application at this 
time, uncheck the box and click Finish.  You can start ACRES by clicking on the 
Start Menu, selecting Programs then selecting ACRES, then click on Data Entry. 

 
 ACRES will automatically set the server path for you the first time it is opened, 

but if it does not you will be asked to “Set Server Path.” Set the server path to the 
acres folder.  See figure below.  

 

http://www.hhsc.state.tx.us/rad/index.shtml�
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To Install ACRES on a Network 
Due to permission rights, you might need to contact your Network Administrator 
before installing ACRES on your network. 

 Run installation on the network server, Follow steps 1-3 from “To Install ACRES” on 
page 2. 

 
 If you do not want the ACRES application on the local C: drive of the server copy the 

ACRES folder (include all files and subfolders) to the desired server drive.  
 
 Share the ACRES folder on the Server. 
 
 Install ACRES on the Client Machines (to ensure that they have the .exe and all system 

files).  
 
 Map Network Drive on Client machine to the Server. 
 
 Start ACRES on Client machine and select the "Settings Menu", then select "Server Path."  

Select the network Drive that you mapped and then select the ACRES folder, then select the 
lower case acres folder. Then click Okay. 

 

To Uninstall ACRES 
It is recommended that all Report files be exported before Uninstalling ACRES Data 
Entry.  Exporting is discussed in Chapter 7. 

 To uninstall ACRES from your system select the Start menu, Settings and click on 
Control Panel. 

 
 In the Control Panel click on Add/Remove Programs. 
 
 Select ACRES in the Add/Remove list and click the Add/Remove button.  This will 

remove ACRES from your system permanently.  
 
 Select Remove from the list of options, and the uninstall wizard will guide you 

through the rest of the uninstall. 
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Frequently Asked Questions 
I have entered and saved an explanation, but I need to make a change to it.  How do I edit 
the explanation that I have already entered? 

Many make the mistake of double clicking in the data entry box of the line number. Simply 
go back to the line number where you entered the explanation and double click on the actual 
line number.  This will open a menu box, and then select Edit Explanation.  For instance, if 
you had an explanation on line 12 that you needed to change, double click on the number 12 
to open the menu box. 

 
When I finish my report and export my file, is the report file sent directly to the Rate Analysis 
Department? 

No, when you export your report the data is stored on your hard drive as a provider (.prv) 
file.  Sending in your file and supporting documents are discussed in Chapter 7. 

 
Where is my file saved when I have exported my report data? 

When you export your report data it is saved to a default location on your computer 
UNLESS you have manually changed your export path using the Export menu.  The default 
location for ACRES is c:\acres\Data.  To determine where the file is located click on the 
Export menu and click Set Export Path.  The export path will be shown on the directory 
listing.  

 
I ran the Data Entry Edits Report and corrected the problems, but when I view the report 
again all the error messages are still there. 

When you run the Data Entry Edits Report the report information is saved so that you can 
refer back to it without having to rerun the report every time.  After you have made changes 
you should rerun the Data Entry Edits to allow ACRES to check for corrections.  You will 
notice on the revised report that the corrected edit lines have been removed. 

 
I have entered all of the Report information, but I cannot find where to input the information 
for Schedules A-J or the certification pages.  Are these included in ACRES? 

No, the Schedules and certification pages are not included in the ACRES Data Entry 
application.  The schedules and certification pages are setup in Microsoft Excel and can be 
found at the following website:  
 
http://www.hhsc.state.tx.us/rad/index.shtml   
 
Refer to your edit run report for a list of the schedules that are to be printed and submitted 
along with your other supporting documents. 

 
I used ACRES last year to complete my report, can I view my previous years data? 

Yes, you have the ability to go back and view the reports that were prepared in previous years 
if they were prepared on the same machine/network and have not been removed.   The 
previous years data is for view only purposes and you will notice that you do not have all the 
functions that you have in the current working year.  Selecting a previous year is discussed in 
Chapter 2. 

http://www.hhsc.state.tx.us/rad/index.shtml�
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Getting Familiar with Data 
Entry 
Before you can get started with the Data Entry application, you first need to familiarize yourself with the Data Entry 
home screen. 

The Data Entry Home Screen is available immediately upon opening the Data Entry application.  
The home screen contains Pull-Down Menus, Action Buttons, and the Status Bar.  See Data Entry 
Home Screen in Figure 1.1. 

 

Chapter 

1 
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Pull-Down Menus 
Pull-down menus allow access to the many features of ACRES.  Each Pull-Down menu and its 
related features will be discussed in detail. (Figure 1.1) 

Action Buttons 
Action Buttons represent the most commonly used Data Entry commands.  Also, the Save Work 
button allows the user to save their work before exiting the Data Entry application.  Action 
buttons will be discussed in detail. (Figure 1.1) 

Status Bar 
The Status Bar displays the properties of the currently selected Report, such as, program type, year, 
and contract number.  The Status Bar also includes the calculator status (on/off), and the status 
that the Report is currently in (i.e. In data entry, Passed data entry edits). (Figure 1.1) 

 

Clicking on the File menu activates the pull down menu.  
Within the File menu are the menu commands Restore 

from Backup, Remove Cost Report, Export Cover Sheet Data, Retrieve Exported 
Complete ACRES Reports and Exit. To activate these commands simply highlight the 
command and click.  (Figure 1.2) 

Fig. 1.2 
 
Menu Commands 

 
Menu Title 

 

  
 
 
 

File Menu 
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Restore from Backup  
Restore from Backup is a recovery feature for lost data.  ACRES creates a backup file every 
time work is saved and when exiting from the application.  If for some reason data is lost or 
corrupted, you can recover the data from the point you last saved work.  For this reason, it 
is recommended that you save your work periodically. (Figure 1.2) 
 
Remove Cost Report 
Remove Cost Report allows the user to delete any selected Report.  You must first select a 
contract number before you can use this option.  If a Report is removed, ACRES cannot recover 
the deleted data. (Figure 1.2) 

Export Cover Sheet Data 
Export Cover Sheet Data gives you a means to export all cover sheet data.  This tool was 
established to limit the need to retype information that seldom changes from year to year.  This 
tool will also create a template file (.tpl) that can be used to import cover sheet data next year.  
(Figure 1.2). 

Retrieve Exported Complete ACRES Reports 
Retrieve Exported Reports allows you to pull an exported report back into the ACRES database.  
Also, a complete ACRES report exported from someone else’s computer may also be imported 
even if was not previously stored on your computer.  Once the report has been imported back into 
ACRES, it will now be in the status of  ‘Passed data entry edits.’  This report cannot be exported 
again until changes are made and all edits have been cleared.  (Figure 1.2) 

Exit  
Exit will close the Data Entry application. (Figure 1.2)   
 
 

 

 

 

 

 

 

Always save work before exiting out of the Data 
Entry application.  This can be done quickly and 
easily by clicking on the Save Work button just 
below the file menu. 
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Clicking on the Edit menu activates the pull down menu.  
Within the Edit menu are the menu commands, Run 

Batch Data Entry Edits and Rebuild Computations. To activate these commands simply 
highlight the command and click.  (Figure 1.3)  

 

 
Run Batch Data Entry Edits  
This gives you the option to run Data Entry Edit checks on several contract numbers at the same 
time if more than one contract has been entered into ACRES.  To select several contract numbers, 
hold down the Control (Ctrl) key on the keyboard and click on the desired contract numbers.  
When all desired contracts have been selected, release the Control key and click OK. (Figure 1.3)  
Data Entry Edits are discussed in detail in Chapter 5. 

Rebuild Computations  
Rebuild Computations will calculate all computation lines within the Report.  This option will only 
be used when the Calculator is turned off. (Figure 1.3)  To determine if your calculator should be 
turned off, see page 13, Settings Menu.  

Edit Menu 
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Clicking on the Import menu activates the pull down 
menu.  Within the Import menu are the menu commands 

Build Import Template, Set Import path, Flip Rows and Columns, Import Cost Report 
Data from External Source, Import Explanations from External Source and Import 
Unfinished ACRES Reports. To activate these commands simply highlight the command and 
click. (Figure 1.4)  Importing data is discussed in Chapter 3. 

 

 

Build Import Template 
Build Import Template allows you to design a custom import template.  You can select 
specific line items to import into ACRES. (Figure 1.4) This is discussed in detail in Chapter 3.  
 
Set Import Path  
By setting the Import Path, ACRES knows where to look for the file(s) to be imported. (Figure 
1.4)  This is discussed in detail in Chapter 3. 

Flip Rows and Columns 
Due to the column limitation with most spreadsheet utilities, this tool allows you to set up a top to 
bottom import file, rather than a left to right import file.  This tool can only operate correctly with 
a .csv (comma delimited) file.  (Figure 1.4)  This is discussed in detail in Chapter 3. 

Import Menu 
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Import Cost Report Data from External Source 
Import Cost Report Data allows you to select the file to be imported and begin the import 
process. (Figure 1.4)  This is discussed in detail in Chapter 3. 

Import Explanations from External Source 
Import Explanations allows you to Import Explanations much the same way you would import 
Cost Report Data (Figure 1.4).  This is discussed in detail in Chapter 3. 

Import Unfinished ACRES Reports 
Import Unfinished ACRES Reports allows you to import an unfinished report that had been 
previously exported from your computer (Figure 1.4).  Also, an unfinished report exported from 
someone else’s computer may also be imported even if it was not previously stored on your 
computer. Once the report is imported the report is unlocked and you can begin editing again.  
For information about importing a completed ACRES report, refer to page 7 “Retrieve Exported 
Complete ACRES Reports.” 
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Clicking on the Reports menu activates the pull down 
menu.  Within the Reports menu are the menu commands 

Import File Format, Import Edit Report, Data Entry Edit Report, Data Reports, and 
Status Report.  The Data Reports option opens a list of the types of reports you can print out:  
Cost Report Data, Cover Sheet Data, Explanation Report, and All Data Reports.  To 
activate these commands simply highlight the command and click.  (Figure 1.5)  

Fig. 1.5 
 
Menu Commands 

 
Menu Title 

 

 
 

File Format for Import 
This feature will give you the format of every line number in the Report.  Print a copy of this 
report to aid in the creation of an import file.  The report shows the type and maximum file size of 
the data each report item is expecting. Also, items with an “X” before them have been selected for 
import. (Figure 1.5)  This is discussed in detail in Chapter 3. 

Import Edit Report 
The Import Edit Report allows you to verify that ACRES has recognized all imported files.  The 
report shows what Reports were imported and the template file used.(Figure 1.5). 

Data Entry Edit Report 
The Data Entry Edit Report is a checklist to verify that no errors are present in the Report.  It is 
important that you go through the edit list to check for errors before sending the Report data to 
the Rate Analysis Department. (Figure 1.5)  Data Entry Edits are discussed in detail in Chapter 5. 

Reports Menu 
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DATA REPORTS 
 
Cost Report Data 
The Cost Report Data is a summary report that reflects each Report line item and the 
corresponding value.  It contains everything that was entered into the Report, except for 
the Explanation file.  The Cost Report Data is to be printed and kept for your records. 
(Figure 1.5)  Cost Report Data is discussed further in Chapter 6. 

Cover Sheet Data 
This report is a summary of all contact information including Facility Identification, 
Contracting Entity, Contact, and Preparer. Print this report for your records. This report 
should be placed on top of your supporting documents when they are mailed. 

Explanation Report 
This report will list all data in the Explanation boxes.  Explanation boxes are used to 
collect additional information as required. Print this report for your records. (Figure 1.5)  
Explanations are discussed further on page 26.  

All Data Reports 
This will open all of the reports listed above for review and printing purposes. 
 
 

Status Report 
The Status Report will list all contracts that are in a particular status.  The contracts can be in three 
statuses: In Data Entry, Passed Data Entry Edits, and Exported.  For example, if you 
exported several contracts, you can run a status report to find out which contracts have been 
“Exported.”  The report will list the contract number, status and the date the status was achieved. 
You can select multiple statuses by holding down the Control (Ctrl) button and clicking on the 
status’ you wish to view. (Figure 1.5) 
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Clicking on the Export menu activates the pull down 
menu.  Within the Export menu are the menu commands 

Set Export Path, Export Unfinished ACRES Report and Export Cost Report Data. To 
activate these commands simply highlight the command and click.  (Figure 1.6) 

Fig. 1.6 
 
Menu Commands 

 
Menu Title 

 

  
 

Set Export Path 
This will select the default drive and folder where you would like to save the exported Cost Report 
Data. 

Export Unfinished ACRES Report  
This gives you the ability to export a report before it has been completed.  ACRES will export 
your report into a file with an .unf extension (NH06-000127845.unf).   Rate Analysis will not 
accept this file and it is strictly for your use only.  This export feature offers the user a means to 
take your work between home and office, or between offices.  NOTE: When a report has been 
exported you will continue to be able to view the report, but cannot edit the file until it has been 
re-imported. 

Export Completed ACRES Report  
This feature allows the user to export the Report data to a desired location. Exporting Report Data 
is discussed in detail in Chapter 7. 

Export Menu 
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Clicking on the Settings menu activates the pull down 
menu.  Within the Settings menu are the menu commands 

Server Path, Amend Exported Report and Set Calc Off. To activate these commands simply 
highlight the command and click.  (Figure 1.7) 

Fig. 1.7 
 
Menu Commands 

 
Menu Title 

 

  
 
 
Server Path   
The Server Path is automatically set when Data Entry is opened.  If you are required to change the 
server path, please contact the ACRES Technical Support. (Figure 1.7) Information regarding 
ACRES Technical Support can be found on page 35. 

Amend Exported Report   
When Report data has been exported, you will no longer be allowed to change the data.  If 
changes to the data are necessary, then select Amend Exported Report and it will give you access 
to make changes. (Figure 1.7)   This is discussed in detail in Chapter 7. 

Set Calc Off  
Set Calc Off will turn off automatic calculations that occur when a change is made to the Report.  
The Calculator should be turned off only if it interferes with the operation of your computer.  If 
you turn the Calculator off, you must rebuild the computations when you have finished the data 
entry.  To do so, click on the Edits menu and select Rebuild Computations. (Figure 1.7)     

Settings Menu 
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Clicking on the Version menu will open a window that shows what version of ACRES you are 
currently running.  The Version number will be particularly helpful when calling the ACRES Help 
Line.  The Version number is used by the Technical Support staff to help diagnose any problems 
with ACRES.   (Figure 1.8) 

Fig. 1.8 

 

Version Menu 
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Getting Started with Data Entry 
Now that Chapter 1 has familiarized you with Data Entry, lets get started.  The most 
common Data Entry commands are set up as action buttons on the Home screen.  
These action buttons are Select Report Type, Select Contract and Update Report.  
The Data Entry Edits button will be discussed in detail in Chapter 5. 

 
Select Report Type gives you the option to select from 
several different formats of Reports.  Select the type of 
contract for which you are required to complete a Report.  

Highlight the type of report desired and click to select. (Figure 2.1)  

Fig. 2.1 

 
 

  
 

Chapter 

2 

Select Report Type 
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If you are starting Data Entry for the first time or entering 
a new contract, you must first add the contract number.  
Click on the Select Contract button and click the Add 

button (see figure 2.2).  The Add Contract box will open; enter the new 9-digit contract 
number.  If you do not know your 9-digit contract number; look at your recent 
payment information, your previous Report, or correspondence from the department.  
If you still cannot determine your contract number, please contact the Rate Analyst 
listed on the cover of the “Specific Instructions” manual.  

 

 
Select Contract allows you to open any pre-existing 
contracts.  Simply click on the Select Contract button 
and a list of all previously added contracts will appear.  

To select a contract you can either use the mouse, or type the 9-digit contract 
number into the box.  Click the Select button when you have chosen a contract. 
If there is only one contract in ACRES, it will be selected automatically. 

  

Add Contract 

Select Contract 
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The current work year will automatically be selected by 
ACRES and you cannot change years until you first 
select a report type. However, “Select Year” allows you 

to view reports from previous years.  Click on the Year button and a list of 
previous years will appear.  Simply click the year you would like to view and 
ACRES will load the reports.  If you don’t have any prior year reports stored on 
your computer you will only be able to select the current working year. 
 

Fig. 2.4 

 
 

  
 

Select Year 
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Importing Files into 
ACRES 

ACRES offers the option to import data from an external source.  This 
requires some work on your part to set up a file that ACRES can 
recognize. This chapter will demonstrate the steps needed to create an 
import file. 

If you do not wish to Import data, please skip this chapter and move on to 
Chapter 4, Update Report: Using Data Entry. 

 

The Build Import Template option can be found under 
the Import menu.  This feature allows you to select the 

individual line numbers, for which data will be imported.  To select the line number, 
simply double click on the line number.  The line number will change from black to 
red, indicating that it has been selected.  To deselect the line number just double click 
and it will change back to black, indicating that it is no longer selected.  You must 
individually select each line item for which data will be imported.   

  

The File Format for Import option can be found under 
the Reports menu. This feature will give you the format of 

each individual line number in the Report.  In addition, every line item you have 
selected in the Build Import Template will be denoted with an X to the left of the 
line number.  The report shows the type and maximum file size of the data each report 
item is expecting.  Print a copy of this report to use while constructing your import file.  
For instructions on printing reports, see Chapter 6. 

Important: Files to be imported must be in the ASCII Comma Delimited 
format.  A file that is not in this format cannot be successfully imported. 

Chapter 

3 


Build Import Template 

File Format for Import 
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 Before starting the construction of your import file, ensure 
that the application you are using can save in the Comma 

Delimited format.  One way to check to see if your application has the capability is to 
click on the File menu option and select Save As.  Check the listed formats to see if 
Comma Delimited is a featured format. 

NOTE: Whether importing Report Data, Cover Page information or 
Explanations the principle is the same.  All import files should be set up in the 
same fashion. 

Below are the necessary steps to create an Import file: 

 Format all the cells on your worksheet as Text.  Provider contract numbers start 
with zeros and unless the cell is formatted as text, it will delete the zeros 
automatically.  ACRES will not allow import if the zeros are missing. The .csv file 
will not retain any formatting, therefore, save your file as an Excel file (.xls) and 
when you are ready to import, save a new file off as comma delimited (.csv).    If 
there are any problems with the import file, you can easily open the .xls file to 
make corrections without losing your formatting. 

 

 Data can be entered from left to right (Fig. 3.1) or top to bottom (Fig. 3.2) in the 
spreadsheet. Be aware that some applications have a limited number of 
columns, for example, Excel only allows for 256 columns.  If you are planning 
to import more than 256 line items, create your import file from top to bottom 
(See Figure 3.2).  See “Flip Rows and Columns” on page 22 for important 
information regarding top to bottom import files. 

Creating Import Files 
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 The first cell should always be the contract number.  This is how ACRES 
knows what contract(s) you are importing.  The next cell should be the first line 
item that you selected in the Build Import Template.  Remember that the data 
must match the required format listed on the File Format for Import report.  
Continue entering each subsequent line item selected in the Build Import 
Template.  See Figures 3.1 and 3.2 to view two different examples of import files 
set up in Excel. 

 

 Once all the data is entered for one contract, start the next contract in Row 2 (Left 
to Right) or Column B (Top to Bottom) following the same steps.  Continue this 
process until all contracts have been entered.  (See Figure 3.1 or 3.2) 

 Finally, save the file in the Comma Delimited format. 
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The Set Import Path option can be found under the 
Import menu.  This feature allows you to select the default 

drive and folder that you want ACRES to look in to find your Import files.  The actual 
selection of files to import is done in the Import Cost Report Data feature. 

 

 

The Flip Rows and Columns option can be found under 
the Import menu.  If the import menu was top to bottom 

opposed to left to right (refer back to Creating Import Files), you must flip the file 
before it can be successfully imported into ACRES.  This Flip Rows and Columns 
feature allows you to flip an import file saved in the comma-delimited format. 

   

 Select Source File for Flipping.  You will need to select the drive and folder 
where your Import file is located.  Remember, the file must be in the comma 
delimited (.csv) format in order to flip the rows and columns. 

 

You will only need to Flip Data if you have created an Import file from top to 
bottom, refer to Figure 3.2 

Set Import Path 

Flip Rows and Columns 
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 Select File Receiving Flipped Data.  The flipped data must be stored in a file 
separate from the source file.  Create a new file to receive the flipped data and click 
okay.  You can also select an existing file to receive the flipped data; however, you 
cannot select the source file because the file selected will be overwritten with the 
flipped data.  Once you have created a new file or selected an existing file, you are 
ready to import the flipped data (see “Import Cost Report Data” on page 24). 
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The Import Cost Report Data option can be found 
under the Import menu.  This feature allows you to select 

the file to import into ACRES.   

 If you have already Set Import Path, you can skip this first step.  If you have not, 
select the directory where your file is located. 

  Select the import template to be used with this import. 

  Select the comma-delimited file (.csv in the case of Excel) you wish to import into                                                                                 
ACRES. Click OK and ACRES will begin the process of importing data.  
Remember, the import menu was top to bottom opposed to left to right (refer 
back to Creating Import Files), you must flip the file before it can be successfully 
imported into ACRES. 

 

 
 
The Import Edit Report option can be found under the 
Import menu.  This feature allows you to verify that all 

reports where imported.  The report will give the total contracts imported and the 
contract number of each. 

Import Cost Report Data 

Import Edit Report 
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Update Report: Using 
Data Entry 
 

Data Entry is where you manually enter data directly into ACRES.  
To get to the Data Entry screen, click on the Update Report 
button on the home screen.  The Data Entry screen has a title box, 
and several action buttons.  The title box tells you the type of 
contract, year, contract number, and whether the calculator is on or 

off.  The functions of all action buttons are described in Figure 4.1. 

 
There are several ways to navigate through ACRES.  The user has the option of using 
the Return key, Tab key, Arrow keys or Mouse when moving from one field to 
another.  The Return key will move down the fields and will make a “ding” sound 
every time the key is hit.  If the sound is distracting, use the Tab key as it has the same 

Chapter 
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function as Return key.  To jump around quickly you can click on a field with the 
Mouse.  Also, the Arrow keys can be used to move back and forth through the fields. 

There are also navigation buttons at the bottom of the Data Entry page, see Figure 
4.1.  When using the Previous Page and Next Page buttons, be careful not to click 
too quickly.  It requires a lot of memory to paint the pages on your screen and if your 
system has limited memory resources it may lock up your computer. 

When you start entering data into ACRES, you can skip around and leave line items 
blank until you are prepared to answer them.  However, it is recommended that you try 
to proceed sequentially through the Report.  

 
 
 
When entering data, you will come across Error Messages.  
ACRES uses Error Messages to help prevent the user from 

making improper entries or other common mistakes that delay the report processing.  
Below are a few examples of Error Messages: 

 
When an Error Message appears, a description of the problem will be contained in the 
message box.  To correct the error, click the OK button and then click the Retry 
button. If you wish to proceed and come back to the entry later, click the Cancel 
button to clear the field.  Any errors that are not corrected will appear in the Data 
Entry Edit Checks.  All Data Entry errors must be corrected prior to submission.  

 

Error Messages 
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Attachment Notices are reminders that some action needs 
to be taken.  Be sure that you complete the required action 
that is stated on the Attachment Notice.  Below is an 

example of an Attachment Notice: 

 

 
 
When an entry requires further description, the 
Explanation Box will open automatically.  Enter the 
information that is being requested into the Explanation 

box.  Both text and numbers can be entered in the Explanation Box.  Below is an 
example of an Explanation Box: 

 

 

 If for any reason, you want to go back to the Explanation and make changes or 
correct the entry, double-click on the line number and select Edit Explanation. 

 When you complete your explanation, click Save and move on to the next entry. 

 

 

Attachment Notices 

Explanation Boxes 
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ACRES automatically creates a backup file every time work 
is saved and when exiting from the application.  Restore 

from Backup is a recovery feature for lost data.  If for some reason data is lost or 
corrupted, you can recover the data from the point you last saved work.  For this 
reason, it is recommended that you save your work periodically. 

 

Use the following steps to restore data from a back up file: 

 Open the File menu and select Restore from Backup. 
 
 A message will appear; giving the date and time of the most recent update that 

has been backed up.  You will have the option (Yes/No) to restore from back 
up.  

 
 
Contact ACRES Technical Support to report any problems that resulted in 
the loss of data or having to restore from back up.  Information for 
Technical Support can be found on page 35. 
 

Back Up 
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Checking Data Entry Edits 
Whether you are importing or entering data manually; you are required to check the Data 
Entry Edit Check Report to verify the correctness of the Report prior to submission. 

 

The Data Entry Edit Check Report can be 
created by clicking on the Data Entry Edits 
button located on the home screen (See page 

5).  The report will open automatically after Data Entry has completed running the 
edits.  This report allows the user to verify the correctness of the Cost Report.  Print 
this report as a tool in clearing the edits. For instructions on printing reports, see 
Chapter 6. 

The Data Entry Edit Check Report will display each line item that needs to be 
checked or cleared.  Line items that start with C indicate the item to be fixed is on 
the cover page (ex. C1 means that the first line on the cover page needs to be 
completed).  To the right of the line number is a note that describes the error to 
be corrected. The “M” after the line item indicates that it is a message to be 
checked; it is not an error.  Messages will always appear on  the report, 
whereas error messages will no longer appear after the error is corrected.  
Below is an example of a Data Entry Edit Check Report. 

Chapter 
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Clearing Edits refers to checking or correcting any 
messages that are present on the Data Entry Edits Check 

Report.  Print a copy of the Data Entry Edits Check Report as a guide when going 
back to clear edits. 

Below are the steps required to Clear Edits: 

 Go back into data entry by clicking Update Report on the home screen.  

 Use the Go To button to proceed to the line items that need to be checked or 
corrected.  Refer to the Data Entry Edits Check Report to determine which line 
items need to be addressed. 

 Make any necessary changes to address the indicated line item edit message. 

 Once you have completed all checks and made any necessary corrections, save 
your work and click on the Data Entry Edits button again.  

 The goal is to obtain the message, “Cost Report generated no errors” which 
appears at the end of the Data Entry Edits Check Report.  Repeat steps 1-4 until 
the “Cost Report generated no errors” is obtained. The status “Passed Data Entry 
Edits” indicates that all checks and errors have been completed, and the data is 
now ready to be exported.  Refer to Chapter 7 for information on exporting. 

 

The Data Entry Edit Check Report will ask you to verify 
that the proper information has been input into the 

Explanation Box.  For Example, the report might ask you to check a line item that 
says, “Give a Description and Cost Breakdown showing how money was allocated.”  
Follow the example below to verify Explanations. 

 Go To the line item that needs to be verified. 

 Double Click on the line number.  A menu will open, select Edit Explanation.  
This will open the Explanation Box. 

 Enter the required information into the Explanation Box.  Once all required 
information has been entered, click Save and move on to the next line item to be 
checked. 

 

Clearing Edits 

Verifying Explanations 
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Printing Reports 
 
It is recommended that you print a copy of the Cover Sheet, 
Cost Report Data and Explanation reports after all data entry 
edits have been cleared.  These reports are a summary of the 
Cost Report data and can be kept for your records.  To print 
these Reports click on the Reports menu, click Data Reports, 

and select Cover Sheet, Cost Report Data, Explanation report, or All Data 
Reports.  The Report window will open.  Click the Print button located at the top 
of the window.     
 
Follow this same procedure to print any other report desired during the 
Report preparation. 
 

 

Chapter 
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Sending in Report Data and 
Supporting Documents 
Once you have finished all data entry and you have made all the necessary corrections to the 
Report and have printed your copies of the reports, you are ready to Export the data and email 
the completed report to HHSC. 

 

Exporting your cost report data simply means that 
everything you input into the system for that cost report 

will be compressed into a file and placed in a format that Rate Analysis 
can use to import into their system.  To export the cost report, follow 
the instructions below. *** Remember, a contract cannot be exported 
until it has achieved a status of “Passed data entry edits.”   

1. Click on the Export menu, click Export Completed ACRES Report. 
 
2. Save the exported file to your local hard drive (either using the default location 

c:\acres\data or a location of your choice) OR a 3½ Floppy disk or other drive. 
Click OK.  

 
3. ACRES will automatically name the file according to the contract number. For 

example, if you prepared nursing facility cost report with contract number 
000123456 for the year 2006, your file would be named “NH06-000123456.prv”. 
It is very important that you do NOT change the name of this file.   The 
report is now ready to be emailed to HHSC. 

 
Once you have exported the Report, you will be able to view and print the data, but 
will no longer be able to make changes.  If for some reason, you need to make a 
change after the report has been exported, select the Settings menu and click Amend 
Exported Data.  This will allow you to make changes to the report.  Understand that 
it will be necessary for the amended report to achieve the “Passed Data Entry Edits” in 
order to export the amended report. 

 

Chapter 
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It is important to remember, if any changes have 
been made to the Report since it was last 
exported, it must be EXPORTED again. 
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Once you have cleared all edits and have exported the 
report file, you will need to submit the file via E-mail.  
The ACRES file that you Exported should be attached 
to an e-mail and sent to: ACRES@hhsc.state.tx.us  Once 

the file has been sent, you will receive an E-mail confirmation that it has been 
received by HHSC; please keep this for your records. 
 

 
To attach your report to an email follow the steps below.  **NOTE:  These are 
the basic steps for attaching a file to an email.  The wording or options may be 
different for each email application (system). 
 

1. Open a new email and type in the To: box:  ACRES@hhsc.state.tx.us 
2. Type in the Subject line information to indicate what type of report you 

are emailing (ie. 2006 NF Cost Report, 2006 PHC Annual Report, etc) 
3. In the message section please list the contract numbers for the cost reports 

you are attaching to the email. (ie. NH06-000000000, APH206-000000000) 
4. Type your name or a contact name and phone number in case we have 

questions or problems with receiving the attachment.  See example below.   

Example:       

5. There are several ways to attach a file to an email.  You may have a icon 
on your toolbar that looks like a paper clip; may have a button that says 
File Attach, Attach File, Attachment(s); or you may need to click Insert on 
your menu bar and click attachment. 

6. You may have to browse to the appropriate folder to retrieve the report.  
This will be the folder where you saved the exported data.  If you didn’t 
change the location of the report, the default folder is c:\ACRES\Data.  
**If you are unsure about how to attach a file, please call the ACRES Help 
Line listed on page 35 or use your email systems Help feature. 

All supporting documentation (see check list below) must be mailed to the 
following address: 
 

Sending Data and 
Supporting Documents 

It is important to remember, if any 
changes have been made to the Cost 
Report it must be EXPORTED again. Even if your Report file has been e-mailed, your 

report WILL NOT be considered “Received” until 
all required supporting documentation has been 
received.  (See next page) 
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Mailing Address (regular mail): Physical Address (overnight mail): 
HHSC Rate Analysis  
Mail Code: H - 400 
P.O. Box 149030 
Austin, Texas 78714 

HHSC Rate Analysis  
Mail Code: H - 400 
4900 North Lamar 
Austin, Texas 78751 

 

 I have sent my cost report file(s) as an attachment via E-mail to ACRES@hhsc.state.tx.us 

 Cover Sheet (Contact Information) – see page 12 for information on Cover Sheets 

 Schedules A through L  (if applicable) – schedules can be obtained from Rate Analysis Website 

 Cost Report, Methodology, and Appraisal Methodology Certification pages 

 Attachments  (as specified by Data Entry Edit Check Report) 

 Allocation Summary  (if applicable) 

 Miscellaneous  (if applicable) 

 
Refer to the Specific Instructions for due dates and further information. 
 
Rate Analysis website: www.hhsc.state.tx.us/rad/index.shtml 

C O M P L E T E  T H I S  C H E C K L I S T  T O  E N S U R E  T H E  I N C L U S I O N  O F  

A L L  R E Q U I R E D  M A T E R I A L  B E F O R E  M A I L I N G  
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ACRES Technical Support 
The following technical support options are available for ACRES Data Entry: 

• Call ACRES Technical Support at (512) 730-7404 for assistance with any 
technical issues between 8:00 a.m. to 4:00 p.m. (Central time) Monday through 
Friday. 

Or 

• E-mail ACRES@hhsc.state.tx.us for assistance with technical issues.  Please 
include the ACRES Version number in the subject line of your e-mail. For 
information on Version numbers, refer to page 15. 

If sending an email, include as much information as possible about the problem 
encountered.  Below are a few questions you should address and include in your email. 

1.  Define to the best of your ability the problem you are experiencing with ACRES.  

2. Error number, Title of Error Message, Description of Error Message 

3. How to contact you (telephone and/or an e-mail address) 

 
 
If you are calling the ACRES Technical Support line, you should be ready 
to answer these questions.

Chapter 
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